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Purpose of the Document

The purpose of this document is to explain the QCA4020 which is multi-mode dual band WiFi, Bluetooth
5, and ZigBee (802.15.4). This document contains the features of the QCA4020 and how to configure it.

Document History
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A 5G HUB 8.16.2021 Initial Document
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1 Introduction

This is a miniPCle card that supports multi-mode intelligent connectivity. It supports dual-band WiFi,
Bluetooth 5, and ZigBee. It is based on Qualcomm QCA4020 System-On-Chip (SoC). It has low power
SoC that integrates a Cortex M4F for application processing, Cortex MO for network stack
processing, and a separate processor for Wi-Fi stack designed to enable a highly concurrent
multiple radio solution.

The QCA4020 SDK pre-integrates support for advanced security features and multiple software
and cloud ecosystems.

Designed to address loT fragmentation and support for interoperability, this solution is ideal for
multiple loT industries from home control and automation, networking, home entertainment
and smart cities.

Feature Highlights

e  Multi-mode SoC supporting dual band Wi-Fi, Bluetooth 5, and IEEE 802.15.4 concurrently

e Dedicated processor for Bluetooth LE LC and 15.4 MAC

e Dedicated processor for 802.11 a/b/g/n

e Zigbee 3.0 and OpenThread support

e Isolated power islands for low power operation

e Advanced hardware-based security featuring secure boot, trusted execution environment,
encrypted storage, key provisioning and application-level security

e Comprehensive set of peripherals and interfaces: SPI, 12C, UART, HS-UART, ADC and GPIOs

e Integrated sensor hub for post-processing designed to enable low power sensor use cases

e Small package size allows for optimized form factors

e 300+KB RAM reserved for applications

e Bluetooth radio details: v5.0 with PA =+4dBm/+10dBm (for Long Range)

e 802.15.4 radio details: 2006 compliant, 15.4e, 2.4GHz DSSS +4dBm/+21dBm (for Long Range)

Specifications

Wi-Fi

Standards: 802.11a/b/g, 802.11n
Wi-Fi Spectral Bands: 2.4 GHz, 5 GHz
Peak Speed: 150 Mbps

MIMO Configuration: 1x1 (1-stream)

Bluetooth
Bluetooth Specification Version: Bluetooth 5.0

Bluetooth Technology: Qualcomm Bluetooth mesh, Bluetooth Low Energy

802.15.4
LR-WPAN Protocol: Thread, Zigbee

usSB
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USB Version: USB 2.0

CPU
CPU Clock Speed: Up to 128 MHz
CPU Cores: Arm Cortex-M4F CPU, Arm Cortex-MO0 CPU, Tensilica Xtensa

Security Support

Security Features: Application-level Security, Hardware-based Crypto Engine, Key Provisioning
Security, Qualcomm® Trusted Execution Environment (TEE), Secure Boot, Secure Storage, Software
Image Encryption, True Random Number Generator

Wi-Fi Security: WPS Interface

2 QCA4020 miniPCle Layout

The following figure explains the QCA4020 miniPCle. It has two headers P1 and P2 which exposes many
of the GPIOs and interface of the QCA4020. In addition, it has a JTAG interface for debugging and
flashing image. In addition, it has Emergency Download Mode (EDL) jumper header.

1°CA TOSM

1- QCA402 M20 module
2- miniPCle Interface

3- J3 (EDL)

4- J2 (configure JTAG interface)

5- J1 (Force JTAG) 5- miniPCle socket
6- P2 Header

7- P1 Header

8- JTAG Interface

Figure 1: QCA4020 miniPCle Layout.

QCA4020 miniPCle Copyright © 5GHUB.US


https://5ghub.us/

The following figure shows the size and dimension of the QCA4020 miniPCle.
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Figure 2: QCA4020 miniPCle Physical Dimension.

3 QCA4020 miniPCle Pin Out

The QCA4020 is miniPCle card and interface. The following figure shows the pin out of the miniPCle:
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Figure 3: QCA4020 miniPCle Pin out.

To use the miniPCle module, you can use USB adaptor (also know as Raspberry Pl HAT). The miniPCle pin
mapping as in the table below. If the miniPCle is used with he Raspberry PI HAT, miniPCle pins are
mapped to Raspberry Pl for additional functionality and interface to Raspberry PI.

Table 1: QCA4020 miniPCle Interface.

PIN # QCA4020 QCA4020 GPIO | Raspberry Pl PIN#
PIN#
1 WAKE-UP GP1029_BE
2 VCC_3V3
3
4
5
6
7
8
9
10
11 MO&M4_UARTO_RX GPIO8_BE GPIO 14 (8)
12
13 MO&M4_UARTO_TX GPIO9_BE GPIO 15 (10)
14
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15

16

17

18

19

20

21

22

CHIP_PWD_L_BE

T4

23

24

25

26

27

28

29

30

12C0_MASTER_SCL

GPIO10_BE

GPIO 19 (35)

31

DTR

33

32

12C0_MASTER_SDA

GPIO11_BE

GPIO 18 (12)

33

34

35

36

USB20_DM_BE

USB20_DM_BE

37

38

USB20_DP_BE

USB20_DP_BE

39

40

41

42

LED_ZIGBEE

GPIO13_BE

43

44

45

SPI_SLAVE_CLK

GPIO18_BE

GPIO 11 (23)

46

LED_BLE

GPIO60_BE

47

SPI_SLAVE_MOSI

GPI023_BE

GPIO 9 (21)

48

LED_WLAN

GPIO12_BE

49

SPI_SLAVE_MISO

GPI020_BE

GPIO 10 (19)

50

51

SPI_SLAVE_CS_N

GPIO19_BE

GPIO 8 (24)

52

QCA4020 miniPCle
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4 How to flash Image to QCA4020 miniPCle

Flashing the image o the QCA4020 miniPCle can be done using either of the following two methods:

4.1 Method 1: Through Emergency Download Mode (EDL)

In this step up, user can do the following:

1- ConnectJ3 (PIN 1 and PIN 2). This is the GPIO22_BE used for EDL.
2- Connect the USB cable between the PC and the USB port of M20.

4.2 Method 2: Through JTAG

In this step up, user can do the following:

1- ConnectJ1 (PIN 1 and PIN 2). This is the GPIO20_BE which used to force JTAG mode
2- Connect JTAG cable to the JTAG 10-PIN header which includes the signals TCK, TDI, TDO, TMS

Follow normal procedure to flash the *.elf file over the JTAG interface.

QCA4020 JTAG pins used as in the following Table:

Table 2: JTAG Interface.

QCA4020 PIN# JTAG Signal
GPIO_50 JTAG3_BE_TCK
GPIO_51 JTAG3_BE_TDO
GPIO_52 JTAG3_BE_TMS
GPIO_53 JTAG3_BE_TDI

J2 on the QCA4020 is used to configure JTAG. Connecting J2 (PIN 1 and PIN2), force the following JTAG
configuration:

Table 3: J2 Setting for JTAG Interface.

Boot_Configure_B | Boot_Configure_B | Boot_Configure_BE | JTAG Interface
E_OGPIO_9_BE E_1GPIO_25_BE _2GPIO_18_BE for M4
0 0 1 JTAG in
GPIO[53:50]
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5 QCA4020 Pin Out

The QCA4020 has abundant number of pins and GPIOs and functionalities which are exposed through P1 and P2 jumper headers. The following
table summarizes all pins exposed through P1 and P2 jumper headers and their hardware functionalities.

Table 4: P1 and P2 PIN Mapping.

Header and PIN GPIO # SPl or 12C orQSPI UART AL PTA
SenseADC
P2-PIN1 3.3V
P2-PIN2 GPIO4_BE
P2-PIN3 GPIO5_BE BT_ ACTIVE
P2-PIN 4 GPIO6_BE WLAN_ACTIVE
P2-PINS GPIO7_BE BT_ PRIORITY
P2-PIN6 GPIO14_BE HS_UARTO_DM_CTS
P2-PIN7 GPIO15_BE HS_UARTO_DM_TXD
P2-PINS GPIO16_BE 12C1_Master_SCL HS_UARTO_DM_RFR BT_ ACTIVE
P2-PIN9 GPIO17_BE 12C1_Master_SDA | HS_UARTO_DM_RXD WLAN_ACTIVE
P2-PIN 10 GPI024_BE
P2-PIN 11 GPI026_BE
P2-PIN 12 GPI0O27_BE
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P2-PIN 13 GP1028_BE
P2 -PIN 14 GPI030_BE
P2 -PIN 15 GPI031_BE
P2-PIN 16 GP1032_BE
P2-PIN 17 GPI033_BE
P2-PIN 18 GND
AO
P1-PIN 10 (SENSEADC_1_BE)
Al
P1-PIN9 (SENSEADC_0_BE)
P1-PINS8 GPIO_41_BE
P1-PIN7 GP1048_BE
P1-PIN6 GP1049_BE
P1-PIN5 GPI054_BE SENSEADC2
P1-PIN 4 GPI055_BE SENSEADC3
P1-PIN3 GPI056_BE SENSEADC4
P1-PIN?2 GPI057_BE SENSEADC5
P1-PIN1 GPI058_BE SENSEADC6

QCA4020 miniPCle
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6 Software Tools to be Installed

Please install the following tools

Python 2.7.X (Download Python | Python.org)

Eclipse IDE for C/C++ (Eclipse IDE for C/C++ Developers | Eclipse Packages)
This is a GUIl-based integrated development environment

Supported Version: Oxygen version - Release 4.7.2

Java:

Eclipse IDE has dependency on Java, JDK 8 or higher

OpenOCD (Download OpenOCD for Windows (gnutoolchains.com))
version 0.10.0 [2017-06-09]

GNU Arm Embedded Toolchain (GNU ARM Toolchain)

version 6.x

Qualcomm SDK for QCA4020: The SDK contains sample demo applications with source code to
demonstrate different features and technologies that QCA4020 supports.

7 Setting Up the Software Development Environment

7.1 Python
After installing Python, add the path to python.

Example:
If python.exe is in the folder

| C:\CRMApps\Apps\Python276-64 \

set path as follows:

| %PATH%=%PATH%:C:\CRMApps\Apps\Python276-64 |

7.2 Java
After installing Java, add path to Java.

Example:
If Java.exe is in the folder

‘ C:\ProgramData\Oracle\Java\javapath ‘

set path as follows:

| %PATH%=%PATH%: C:\Program Files\Java\jdk1.8.0_161\bin \

7.3 OpenOCD
OpenOCD plugin is required to establish the connection between Eclipse IDE and onboard FTDI JTAG

debugger. After installation, add the path to OpenOCD.

Example:
If openocd.exe is in the folder

QCA4020 miniPCle Copyright © 5GHUB.US
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https://www.python.org/downloads/
https://www.eclipse.org/downloads/packages/release/oxygen/3a/eclipse-ide-cc-developers
https://gnutoolchains.com/arm-eabi/openocd/
https://developer.arm.com/-/media/Files/downloads/gnu-rm/6-2017q2/gcc-arm-none-eabi-6-2017-q2-update-win32-sha2.exe?revision=419232c3-aefe-4049-a88a-7b4ea055ebc7?product=GNU%20Arm%20Embedded%20Toolchain,32-bit,,Windows,6-2017-q2-update

‘ C:\Program Files\OpenOCD-20170609\bin

set path as follows:

‘ set %PATH%=%PATH%:C:\Program Files\OpenOCD-20170609\bin

7.4 GNU ARM Toolchain
Install the ARM toolchain by running the “.exe” file and make sure you select the option to “Add path to
environment variables” during the final step.

7.5 Setup OpenOCD Plugin Usage with Eclipse

Do the following steps:

1- Go to Help > Install new software in EclipselDE and make sure the following plugin are installed and
enabled by default.

‘& eclipse-workspace - Eclipse IDE - m} X
File Edit Source Refacter Mavigate Search Project Run  Window | Help
02 | B~Q-B B% e | Jig-6~ [ @ Welome
TS Gr DA @ Help Contents Q im |
[ Project Explorer % Search BESY i =F |
» = Helloworld_demo Show Centextual Help =
Show Active Keybindings... Ctrl+Shift+L -
4 Tipsand Tricks... 2
Cheat Sheets... i3]
@ Eclipse User Storage » 5‘
“#%  Perform Setup Tasks... O
" Check for Updates 5
i Install New Software... =
ﬁ Eclipse Marketplace... g
S About Eclipse IDE EI
W Donate
Contribute

b§ Helloworld_demo
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-
S Preferences

type filter text

General
3 CfC+s
Changelog
» Dacker
Help
Install/Update
Automatic Updates
Available Software Sites
Library Hover
> MCU
> Mylyn
Oomph
Remote Development
> RPM
> Run/Debug
SWTChart Extensions
Terminal
> TextMate
Tracing
Validation
Version Control (Team)

> XML

£

@ iu s @

Softy Sites 2 v 8
‘ type filter text x ‘
Name Location Add...
#l2021-03 http://download.eclipse.org/releases/2021-03 e
Edit

O #cor http://download eclipse.org/tools/cdt/releases/10.2 =
'53 coT https://download.eclipse.org/tools/cdt/releases/10.2 Sl

] Embedded C/C++ v6ux Updates https://download.eclipse.org/embed-cdt/updates/vé/

] Latest Eclipse IDE Packages Release  https://download.eclipse.org/technology/epp/packages/latest/ Reload

1 vﬂ Latest Eclipse Simultaneous Release  https://download.eclipse.org/releases/latest

O 4 Linux Tools http://download eclipse.org/linuxtaols/update Enable
4] The Eclipse Project Updates http://download eclipse.org/eclipse/updates/4.19 : =
mport...
O 1& Trace Compass http://download.eclipse.org/tracecompass/master/repository il
O #fl Trace Compass Incubator http:// download.eclipse. org/tracecompass.incubator/stable-6.3... T
< >
| Apply and Close Cancel

2- Set path to openOCD. Restart the Eclipse IDE and under Window -> preferences. Set path to

openOCD as seen below:

-
S Preferences

type filter text

> C/C++
Changelog

> Docker

- Help

» Install/Update

» Library Hover

v MCU
Global Arm Toelchains Paths
Global Build Tools Path
Global OpenOCD Path
Global pyOCD Path
Global QEMU Path
Global RISC-V Toolchains Paths
Global SEGGER J-Link Path
Workspace Arm Toolchains Paths
Workspace Build Tools Path
Workspace OpenOCD Path
Workspace pyQCD Path
Workspace QEMU Path
‘Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path

> Mylyn

» CDomph

» Remote Development

O x

oon

Global OpenOCD Path I Eoiw

Configure the location where xPack OpenQCD is installed, The values are stored within Eclipse. Unless redefined more
specifically, they are used for all projects in all workspaces,

After installing OpenOCD updates, restart Eclipse for the defaults to be re-evaluated and use the Restore Defaults button to
configure the new location,

Executable: | openocd.exe

Folder: | CANB_loT_Projects\PCBandGitHub\Tools\OpenOCD-20170609-0.10.04bin Browse... cPack..

| Restare Defaults | Apply

Apply and Close Cancel

3- After installing the Qualcomm SDK, QCA4020 OEM SDK+CDB, Demos samples are in the following

folder:

| target\quart\demo\

QCA4020 miniPCle
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4- Install the QCA plugin jar file available at

| <SDK_source>/target/quartz/demo/EclipseSupportFiles

folder.

installed.

5- Make sure all environment variable are set up correctly

Copy the jar file (QCA402x_plugin.jar) to the “dropin” folder under the Eclipse IDE installed

Edit environment variable

CihlUsers\hossatAppDatatLocal\Programs\Python Python2?

C:\Program Files (x86)\GNU Arm Embedded Toolchain’ 10 2020-g4-major'bin
CAMB_loT_Projects\PCBandGitHub\ Tools\ 0 penQCD-20170603-0.10.00bin
C:\Program Files\Java'jdk1.8.0_291\bin
%USERPROFILEZ\AppDatatLocal\Microsoft\WindowsApps
CihlUsers\hossatAppDatatLocal\GitHubDesktop'bin

CAMinGWhbin

ChlUsers\hossa\AppDatatLocal\Programs\Microsoft Vs Code\bin
Ch\Users\hossalAppData\Roaminginpm

Mew
Edit
Browse...

Delete

Move Up

Move Down

Edit text...

Cancel

8 Importing “Hello World” Application

1- Install Eclipse project files for sample demo applications.

To install there is eclipseSupport.bat for Windows and eclipseSupport.sh for Linux in the

following folder:

Restart the Eclipse IDE if running. To restart Eclipse, click on the File->Restart after the plug-in is

| <SDK_source>/target

2- Open a terminal window and navigate to

| <SDK_source>/target

3- Run the following command

QCA4020 miniPCle Copyright © 5GHUB.US
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‘ sh eclipseSupport.sh

Or

‘ eclipseSupport.bat

After executing the script, the Eclipse project files .cproject, .project and .settings folder are updated
in the respective folders of the demo application.

4- Open Eclipse application and Go to File->Open Project and choose the folder of the “Hello World”
application and check the box beside the application. Click Finish

S Import Projects from File System or Archive m}

Import Projects from File System or Archive

X
=
€3 Invalid directory or archive file 7

IO TN |1\ C40201SDK)\ gcadl20-or-3-4 gea_oem sdk-cdb-master-2e23b 1b093331 1a33dc030ed0r4/dedb31 7954\ argetiquarz\demo\Helloworld_dem: ][ pirectory... Archive..
type filter text | Select All
Folder Import as Deselect Al

0 of 1 selected

[ Hide already open projects

[ Close newly imported projects upon completien
Use installed project configurators to:

Search for nested projects

Detect and configure project natures

Working sets
[1Add project to working sets New...
Select...
Show other specialized import wizards
@ < Back Next > Finish Cancel

5- To debug the project, set the Debug Config. Go to Run->Debug Configuration->GDB OpenOCD. Set
the Application and OpenOCD options as show in the images below. Select Quartz.elf as the C/C++
application. If you have already built the image, select Disable auto build. If image is not built, select Use
workspace settings.

QCA4020 miniPCle Copyright © 5GHUB.US
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= Debug Configurations m} X
Create, manage, and run configurations
CE®BEX DT~ Name: | Helloworld_demo
[ type filter text ] Main| %5 Debugger| b Startup| & Source| [T] Common| 2, SVD Path
[E] ¢/C++ Application R
[€] C/C++ Attach to Application
[E] C/C++ Container Launcher [ Hetlo worla Browse...
[] C/C+ Postmartem Debugger C/Cs+ Application:
E E”: E” Ee”:"te Application [kenacaaoac sk qead020-or-3-4_gea_oem _sclk-cdb-master-223b7b0933311233dc090ed0f647de9b 317954 targ et\ quartz\demo\ Helloworld_demo\build\gecioutput\ Quartz.eff
i C/Ces Uni
[&] GDE Hardware Debugging Variables.. | Search Project..| | Erowse..
v [£] DB OpenOCD Debugging e s e
[£] Helloworld_demo
[&] GDE PyOCD Debugging Build Configuration: |Use Active v
[E] GDB QEMU Debugging ] i
[£] GDB SEGGER -Link Debugging (O Enable auto build O Disable auto build
= Leunch Group @ Use workspace settings Configure Workspace Seftings...
Filter matched 13 of 13 items Revert Apply
®
6- In the Debugger window, provide the openocd executable path with config option
. .
-f ${project_loc}\build\gcc\qcad02x_openocd.cfg
7- Provide the arm-none-eabi-dgb executable path for the GDB client as seen below.
= Debug Configurations m] X

Create, manage, and run configurations

BRCEL

Name: | Helloworld_demo.

[ type filter text

Main | 35 Debugger| B Startup | % Source| [7] Common| %, SVD Path|

C/C++ Application
[E] C/C++ Attach to Application
[E] C/C++ Container Launcher
C/C++ Postmortem Debugger
[E] C/C++ Remote Application
Cif C/C++ Unit
[£] GDB Hardware Debugging

+ [C] GDE OpenCD Debugging

[t ] Helloworld_demo

[£] GDB PyOCD Debugging
[5] GDB QEMU Debugging
[€] GDB SEGGER J-Link Debugging
& Launch Group

Filter matched 13 of 13 items

Open0CD Setup A
Start OpenOCD locally

Executable path: | C:\fTools\ OpenOCD-20170609-0.10.0kbin'openocd.exe | Browse..| Variables...

Actual executable: | C:\Tools\OpenOCD-20170609-0.10.0\bin'\openocd.exe |

(to change it use the globsl or workspace preferences pages or the project properties page)

GDB port:

Telnet port:

Tel port:

Config options: -f C:s\QCA4020\5DK\qcad020-or-3-4_geca_oem_sdk-cdb-master-2e22b7b0933311233dc090ed0f647dedb31d 7954\ target\quartz\ demo

\Helleworld_demet\build\gcch\gead02x_openocd.cfg

Allocate console for Open0CD Allocate console for the telnet connection

GDB Client Setup
Start GDB session

Executable name: | CA\Program Files (x86)\GNU Tools ARM Embeddedh6 2017-g2-update\bin\arm-none- eabi-gdb.ere | Browse... | Variables...

Actual executable: | C\Program Files (xB6\GNU Tools ARM Embedded\6 2017-q2-update\bin\arm-none-eabi-gdb.exe |

Other options: | |

v

| Revert || Appy |

()

QCA4020 miniPCle
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9 Building “Hello World” Application

To build the application, do the following:

1. Go to Project properties->Configure build. Right-click on the project name in project explorer and
go to Properties

2. Verify the build command and the build directory in the Builder settings tab.

3. Go to C/C++ build and set the build command to “build.bat”, and the build directory to “path to
source” as in the following screenshots.

4. Click Apply and Close

S Properties for Helloworld_demo m] s
type filter text | | crcs+ Build Gy §
» Resource

Builders :
5 CfC++ Build Configuration: |Default [ Active ] ~ | | Manage Configurations...

» CfC++ General
Linux Tools Path
Project Matures =l Builder Settings (@) Behavior < Refresh Policy
Project References

Run/Debug Settings Builder
Task Repository Builder type: External builder
Task Tags [] Use default build command
> Validation
WikiText Build command: | build bat Variables...

Makefile generation
[] Generate Makefiles autornatically Expand Env. Variable Refs in Makefiles

Build location

Build directory: | ${workspace_loc:/Hellowerld_derno/build/gec}

Workspace... | Filesystem...|  Variables...

Restore Defaults Apply

(‘?) Apply and Close| | Cancel

S Properties for Helloworld_demo [m] bt
type filter text | | crcs+ Build Gy §
» Resource

Builders ; -
s IETCEEHm Configuration: | Default [ Active ] ~ | Manage Configurations...

» CfC++ General
Linux Tools Path
Project blatures El Builder Settings (@ Behavior * Refresh Policy
Project References
Run/Debug Settings Build settings
Task Repository Stop on first build error [“1Enable parallel build

Use aptimal jobs {12,

Task Tags
5 Validation Use parallel jobs: |12 s

WikiText Use unlimited jobs
Workbench Build Behavior
Workbench build type: Make build target:
[1 Build on resource save (Auto build) | all Variables..,
MNote: See Workbench automatic build preference
Build (Incremental build) [ 020 cdlb 2p0 | | Variabes...
Clean [ clobber | | variables...

Restore Defaults Apply

(‘?) Apply and Close| | Cancel

QCA4020 miniPCle Copyright © 5GHUB.US
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5. Build the application and you will see the following message in the Console Window

Building exportiplatform_cem_mom.c
Building export\DALConfig devcfg.c
Building export\DALConfig fom.c
Building exporthdevcfg_devcfg_data.c
Building exportidevcfg_fom_data.c
Building export\UsrEDL.c

Building export\flash_init_config.c
Attempting to convert windows paths: output\LinkerLibs.txt
Generating Linker Scripts...
Linking...

Hashing...

18:53:16 Build Finished. @ errors, @ warnings. (took 1m:21s.44ms)

[

S eclipse-workspace - Eclipse IDE | *
File Edit Source Refactor MNavigate Search Project Run  Window Help
rHE B Bifgia|ig-&8-E-F-%-0-8-Q-®p s~
rEr GGy | et Q ®| E
[y Project Explorer '5_ Problems J=) Tasks [ Console [T Properties i | b qp \:="=| _a = |15k El [l = 10 i -E'I
> 2 Helloworld_demo O Build Lonsale-{Helloworkd demal e
18:51:55 **** Incremental Build of configuration Default for project Helloworld demo **** B
build.bat t 4828 cdb 2p@ &
Python version:Python 3.9.5 (=]
Building Quartz Helloworld Demo for w2 Chipset =
RTOS threadx —
CHIPSET VARIANT qcad482e &
Exporting Device config files.... in
GENERATING DEVCFG.... =
Building hello world.c =
Building palipal.c _y
Building exporti\platform_cem.c o=
Building exporti\platform_ocem_som.c @

The output and *.elf files are generated and available under the output folder:
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| it + | output
Home Share View
= ot T T
» o = o v
u Wi Copy path L g x A .U. |
Pinto Quick Copy Paste Move Copy Delete Rename Mew Properties
access || Pasteshortcut g to - folder - &
Clipboard Organize New Open
<« - A <« quarz » demo » Helloworld_demo » build » gcc » output L ]
el
5 MName Date modified
# Quick access
ohjs 8/18/2021 T:14 PM
I Desktop o ) ) _
~ LinkerLibs.txt 8/18/2021 .14 PM
¥ Downloads ¥ | Quartzelf B/18/2021 7:15 M
= Documents * | Quartzld 8/18/2021 7:15 PM
DocumentsMBackup o B Quartz.map /1872021 15 PM
& Pictures < | Quartz HASHED elf 8/18/2021 T:15PM
PCBandGitHub o | Quartz HASHED hash 8/18/2021 .15 PM
GitHubRepository | Quartz HASHED_combined_hash.mbn 8/18/2021 15 PM
| Quartz_HASHED _hash.hd 8/18/2021 T:15PM
Quectel o : _
| Quartz HASHED_merged.elf 8/18/2021 .13 PM
Uofi * | Quartz HASHED_nohash.elf 8/18/2021 T:15 PM
DocsBFighiVideo: | Quartz_HASHED_phdr.pbn 5/18/2021 7:15 PM
DataSheets * | Quartz_nocompact.elf 8/18/2021 715 PM
Invoices *
v o<
13 items

Open L Select all

Edit Select none

History - Invert selection
Select

2 Search output

Type

File folder

Text Document
ELF File

LD File

Lirker Address Map
ELF File

HASH File
MEM File

HI File

ELF File

ELF File

PBN File

ELF File

Size

4
19,428
472
9.8M1
490

1

1

1

486
486
450

18,428
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10 Flash the Application to the QCA4020 miniPCle using USB

You can flash an application to the QCA4020 miniPCle over the USB port. To do so, follow the following
steps:

1- Connect a jumper on J3 to short-circuit it. This puts the QCA4020 in EDL (Emergency Download
Mode) which allows to download an image to the QCA4020 flash.
2- Connect a Micro USB cable between USB port on the USB adaptor (HAT) and a USB port on a

Windows PC.
Open the device manager and you shall see Qualcomm DLoader is enumerated on a serial port (i.e.,

COMA4O0 in this case).

% Device Manager
File Action View Help
&= @ Bm =

v 8 LAPTOP-HOSSAMMEW =
I Audio inputs and outputs

5| Biometric devices
0 Bluetooth
@_‘ Cameras
[ Computer
e Disk drives
[Gd Display adapters
i Firmware
Hurman Interface Devices
_"|“; Imaging devices
? Junge Connectivity
Keyboards
L1 Memory technology devices
@ Mice and other pointing devices
[ Monitors
F Network adapters
v [ Ports (COM & LPT)

0 )
i Qualcomm HS-USB QDLoader 9008 (COMAD)
VAR | B Ll A

= Print queues

= Printers

3- Use the python-based tool called gflash.py (which is included in the QCA4020 SDK). The tool
allows flashing images over USB. The tool is available at the following folder:

[ target\build\tools\flash

If the tool is invoked without any optional parameters, it does he following:

a) Generate a default firmware descriptor table.
b) Generate a default partition table.
c) Flash the default sample application *.elf files to the qca4020 flash.
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When you run this tool with -h parameter, you get the following as in this screenshot:

BE¥ Command Prompt - O X

rmine SDK

$COMM_PORT si

4- Run the following command to flash the application to the QCA4020

python gflash.py --comm_port 40 --app C:\QCA4020\SDK\qca4020-or-3-4_qgca_oem_sdk-cdb-
master-
2e23b7b0933311a33dc090ed0f647de9b31d7954\target\quartz\demo\Helloworld_demo\build\g
cc\output\Quartz_HASHED.elf

Noe the image to be flashed is the Quartz_ HASHED.elf.

You shall see the output as in the below screen shoot which indicates the image is successfully flashed to
QCA4020.

@8 Command Prompt — m] X

ptor Table @ Fi

8@ Func
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11 Flash the Application to the QCA4020 miniPCle using JTAG
You can use JTAG interface on the QCA4020 miniPCle to flash the image. A SEGGER J-link hardware is
used wit connect and interface to the JTAG.

On the QCA4020 miniPCle, do the following

- ConnectJ1 (PIN1 and PIN2). This force JTAG mode
- Connect J3 (PIN1 and PIN2). This enable JTAG interface

On Windows environment variables, add the following environment variable:

- JLINK_PATH set it to J-link GDB server executable file (e.g., C:\Program Files

(x86)\SEGGER\JLi

- CLIENT_PATH set it to ARM GNU tools (e.g., C:\Program Files (x86)\GNU Arm Embedded

Toolchain\10 202

nk)

0-g4-major\bin)

Using Eclipse IDE, go to Run->External Tools->External Tools Configurations and add a new
configuration. Point to the flash.bat file in the SDK which is used to configure and launch GDB server.

Click Apply and then Run.

CRe@®|oy-

type filter test

Ty Program
G FG Fleshing
4 CoenCCOTAG Flashing

Fifter matched 2 of 3 items

2

Warking Directary:

[ e AR SR a3 _egea_oven_salb el pevastior- T3 TS327 1 3 Sube 190 AN Tl T T gt et Hilnwssnled_liemad buiel e,

Asguments:

Browse Workspece.,| | Erowse File Systern... Varial

Potes Enciose an argument containing spaces using double-guotes (7.

Revert

vanabies...

Apply

Clorke.

You will see the following screenshot and prompted to select device or core. Choose Cortex-M4. Click

OK.
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- (SIL RN BrD-Qe = B~ T

LateEnim = | |Owesl v

- .

Tree softuee
+ 10 wam

Eribite It

Eclipse will start flashing the image to the QCA4020 miniPCle over JTAG. You will see the following
screenshot.

]

zrle_dessibul ldige

-xpace /CREud L, 3.4.r2-a0
5 TOT GF. 3. &, - 00000 -GIH-_ME10201 4

BG5S Twa Akl
Bxedc lnm Bxlocamene

o kA e R 11

BT Ograunes

FeagPrograsaer .o, 10ne &
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When flashing is completed. You will see the following screen shoot with the output:

Flash Operation Completed Successfully...
Stopping GDB server....
SUCCESS: The process with PID 23756 has been terminated.

£y Projunt Explonws B2

L letanns_dema

weid Initiniize Desolvodd]

MAL_COMSOLE WALTE_STNINS LITERAL["S.ILlu World duse  melivec Lo QU& [uE \u"‘J;
PAL_CUMAR E WAL 1IN _LLI SR PR LB GE LANE SN ) |

woid nep_startinmally oold

qury thread oktr s ™
Quit theogd £ i
int

Bl s

[ Prettemns 3 Eveeubiiics () Debugges Consake
v Progiam] GOS0 Fosfects PLE 2 24,00 peen sl cdb

"R % e 2 EE|

o ®| S
i ¥ |

am a0

Eoor-=n

Huneni Tr dadmcLE
M T ALIRRAAAER

£/ CMMEGLLdS/TOT 0T, 3 4. L B0001 QZHn 2 20216201 i _pre ageteelsd ftagorey

CIPE.LLde/ TOT. 42,3 4.1 BiL Qibw 2_2020;
i 2_duEe i

stocping
SUCCESST The orocess wdth FID 13756 Fas seen trrednsted,
c : !

irkahle St Incart 8550

€. Linz 223,

After finishing flashing the image, make sure to remove J1 & J3 on QCA4020 miniPCle to exit JTAG mode.
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12 Connecting QCA4020 to Serial Terminal Through UART
You can use the QCA4020 miniPCle when mounted on USB adaptor (HAT) with any device that has UART

(Tx/Rx) interface such as a Raspberry Pl board, Arduino board or any other hardware board, with UART
interface.

You can also use and connect the QCA4020 miniPCle/USB adaptor (HAT) to a USB port in the
computer through a USB-to-UART cable. You can use cable such as this one:

USB TO UART TTL (Wires) Serial Cable (PL2303HX) MCP00102W Programmer Arduino Compatible in
Elecrow bazaar!

Such a cable has four wires colored as follow:
Red: +5V

: Tx

Green: Rx

Black: GND

Connect the White cable to UART_TX and Green cable to UART_RX. Also connect the Black cable to the
GND).

As in the picture below, connect UART_TX to SJ2 (PIN2) AND UART_RX to SJ1 (PIN2).

|

JP2 JPL

sd2

aRITE
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Make sure when you connect the USB-to-UART cable, it shows correctly in Windows device manager
and all its driver is installed as in this screenshot.

@ Device Manager — O *
File Action View Help

&= HE HE B BEX®

v % LAPTOP-HOSSAMNEW A
i Audic inputs and outputs
3 Batteries
| Biometric devices
9 Bluetooth
® Cameras
E Computer
s Disk drives
[5d Display adapters
* Firmware
Gl Human Interface Devices

3% Imaging devices
? Junge Connectivity
Keyboards
LI Memory techneology devices
g Mice and other pointing devices
[ Monitors
I Network adapters
v [ Ports (COM & LPT)

y - SOL (COM3)
USE Serial Port (COM31)
rint queues

=i Printers
I Processors

B Comivvidns Admsimmr

13 Using Serial Terminal

It is recommended to use Tera Term tool as the serial terminal. You can download it from here:

https://osdn.net/projects/ttssh2/downloads/54081/teraterm-4.72.exe/

Launch Tera Terminal and select the Serial option and select USB-to-Serial port.

Tera Term: Mew connection x
CTCPHP Host: myhost.example.com
History
- |22
Service: L Telnet TEF purt?,
SSH SSHversion: [SSH2
Other
IP version: |AUTO
® Serial Port: | COM31: USB Serial Port (COM31) ~
oK Cancel Help
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In Tera Term, choose Setup->Serial port and configure serial ports according to the following:

Tera Term: Serial port setup and connection Pt
Port: COM31 ~
New setting

Speed: 115200 v

Data: 8 bit v cancel

Parity: none ~

Stop bits: 1 bit ~ Help

Flow control: none v

Transmit delay

D msecichar El msecfline

Device Friendly Name: USB Serial Port (COM31)

Device Instance ID: FTDIBUSYWID_0403+PID_600147&1CBBEEF7&
Device Manufacturer: FTDI

Provider Name: FTDI

Driver Date: B-16-2017

Driver Yersion: 2.12.28.0

And now you are ready to see the output from “hello World” application on the serial monitor.

v COM31 - Tera Term VT = d >
File Edit Setup Control Window Help

World QCA482A miniPCle
World QCA482A miniPCle
World QCA4828 miniPCle
World QCA4828 miniPCle
World QCA4828 miniPCle
World QCA482A miniPCle

World QCA4828 miniPCle
World QCA4820 miniPCle
World QCA4828 miniPCle
World QCA4828 miniPCle
World QCA4820 miniPCle
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If you are using JTAG mode to flash the image to the QCA4020 miniPCle, you shall see the following
output on Tera terminal

MCOM3T - Tera Term VT — O >

File Edit Setup Control Window Help
Hello Yorld from QCA46828 miniPCle

World from QCA4B28 miniPCle
World from QCA4B28 miniPCle
World from QCA4B28 miniPCle
World from QCA4B28 miniPCle
Yorld from QCA4B28 miniPCle

Yorld from QCA4B28 miniPCle
World from QCA4828 miniPCle
World from QCA4828 miniPCle
World from QCA4828 miniPCle
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14 QCLI Demo Application

CLI demo application is a comprehensive demo that provides a mechanism to demonstrate different and
all features and technologies that QCA4020 miniPCle supports. It also provides reference implementation

and usage of customer facing QAPIs.

The QCLI-demo application is available with the QCA4020 SDK and you can follow the same steps
described before in Eclipse to build and flash it to the QCA4020 miniPCle. Once flashed, you can see
the output on the serial terminal as in the screenshot below. Also, you can exercise connecting to

your home/office WLAN

¥ COM3T - Tera Term VT

File Edit Setup Control Window Help

WHMI: HMI Demo Initialized.

ULAM: WLAN Registered

WLANSP2P: WLAN P2P Registered

Het: Met Registered

Coex: Coex Demo Initialized.

Fulp: Firmuware Upgrade Registered
= LP Registered

em Registered
eFs Registered
rypto Registered
: ZigBee Demo Initialized.
Thread: Thread Demo Initialized.
Platform: Platform Registered
JEOM: JS50N Demo Regist d.
FLASHLOG: FLASHLOG Registered
UART: UART Registered

. Ecosystem
- SecureFs
. Crypto

. ZigBee

. Thread

. Platform

. JSON
. FLASHLOG
UART

The following screenshot shows how to connect to an WLAN access point.
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v COMB31 - Tera Term VT

File Edit Setup Contral Window Help
WLANS> Enable

WLANS > scan

ULAN: Scan result coun

WLANS > scan

LULAN d TPLink

WLAN: bssid hi :?6:ch:d6:5h

WLAN: channel

ULAN: indicator i@

ULAN: security =

REN-WPAZ= <{PSK > {TKIP AES }

WLAN: shell> Scan result count:l
WLANS> SetDevice 1

WLANS> SetlpaPassphrase Yusuf@58209
WLANS> SetUWpaParameters WPAZ CCHP CCHMP
WLANS > Connect TPLink

LLAN:

WLAN: Setting SSID to IPLink

WLAN:

WLANS >
WLAN: devld 1 Disconnected MAC addr B0:08:00:00:80:00

WLANS > Connect TPLink

ULAN:
WLAN: Setting S8ID to TPLink

ULANS >

WLAN: devId 1 Disconnected MAGC addr B0:00:00:00:00:00
WLAN: devid — 1 1 CONMECIED MAC addr b =76

WVLAN: 4 way handshake success for device=1

WLANS > 0
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